
Kansas District Court                     Using CM/ECF Cross-Document Hyperlinks 
                                                                                                December 2009 

CROSS-DOCUMENT HYPERLINKS 
 
CM/ECF now permits court and attorney users to file documents that include hyperlinks to a previously filed 
document in the same case or another case that resides on the CM/ECF system where the filing is being 
entered, or on any other court’s CM/ECF system, as well as to a document that is being filed in the same 
submission, such as exhibits to motions or memos of law.  A document can be linked to another document in 
any federal court’s database if the court is running the appropriate version of CM/ECF that includes the 
hyperlink function: District (Release 3.1); Bankruptcy (Release 3.2); and/or Appellate (available as of July 
2006). 
 
Details on the new functionality: 
 

1. The hyperlink, as set by the filer, may link to the start of the document or to a specific page 
in the document. 

 
2. A filer can file a document that includes a hyperlink to a document that is being filed 

simultaneously (in the same docketing transaction) with the primary document (e.g., a Memo 
in Support of Summary Judgment may have hyperlinks to the attached documents that are 
part of the same docketing transaction). 

 
3. Immediately after a document is filed in CM/ECF, that document will be available to be 

linked as a hyperlink in a subsequently filed document. 
 
4. A hyperlink to a CM/ECF document will be retained even if the case or document is moved 

to a different server. 
 
5. If a user can access a CM/ECF server, but the document cannot be found (e.g., the case or 

document has been deleted), a message will be displayed to that effect.  If a user clicks on a 
hyperlink to a CM/ECF document stored on a server that cannot be accessed (e.g., the 
system is down, network issues), an error message will be displayed. 

 
6. A user cannot access a hyperlink to a restricted document (e.g., a private entry, sealed 

document) unless the user has appropriate permissions. 
 
General assumptions about cross-document hyperlink usage: 
 

1. Any document that includes a hyperlink must also include a description of the standard 
citation to the hyperlinked material.  The hyperlink is a convenience, not a citation 
replacement. 

 
2. The ability to file documents with hyperlinks to any external URL (e.g., Westlaw, Lexis) is 

not affected by the cross-document hyperlink functionality. 
 
3. Editing a docket entry will not affect the unique location of the document. 
 
4. The CM/ECF application will not verify the validity of URLs included as hyperlinks within 

documents filed in CM/ECF. 
 
5. This hyperlink functionality has been tested and works properly with Corel WordPerfect 11 

or higher and Microsoft Word 2002 or higher.  Hyperlinks added to documents created in 
other word processing programs may not function properly once the documents are 
converted to PDF format. 

 Page 1



Kansas District Court                     Using CM/ECF Cross-Document Hyperlinks 
                                                                                                December 2009 

CREATING HYPERLINKS TO PREVIOUSLY FILED CM/ECF DOCUMENTS 
 
To create a link between a document being filed in CM/ECF and a previously filed CM/ECF document, 
follow the steps below: 
 
NOTE: Users should not copy hyperlinks from Notices of Electronic Filing (NEFs).  NEFs contain 
special information that allows them to provide one “free look” to qualified recipients and should 
not be used for Cross-Document Hyperlinks.  Instead of copying hyperlinks in NEFs, users should 
run a report in CM/ECF, such as the Docket Report, and copy the document number hyperlink 
from the report. 
 
STEP 1 Access the appropriate CM/ECF system and run the Docket Report for the case that 

contains the document you want to link to. 
 
STEP 2 Locate the document among the docket entries. 
 
STEP 3 Copy the URL of the document to the clipboard.  To do this, hover over the document link 

and click the right mouse button.  Select Copy Shortcut (Internet Explorer/Netscape) (Figure 
1) OR Copy Link Location (Firefox).  NOTE:  The document link is represented by a 
number with an underscore (e.g., 2). 

 
NOTE: If you want to link to an attachment to a primary document filed in CM/ECF, you must select the 
hyperlink to the attachment from the Document Selection Menu (Figure 2).  For example, if you are linking 
to a memorandum of law filed with a motion, you must first select the motion from the docket sheet.  When 
the Document Selection Menu appears, copy the URL of the attachment by following the procedure outlined 
above. 
 
 

Second, select Copy 
Shortcut or Copy Link 
Location. 

First, hover over the document link and 
click the right mouse button.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
                             Figure 1: Internet Explorer 
 
 

 Page 2



Kansas District Court                     Using CM/ECF Cross-Document Hyperlinks 
                                                                                                December 2009 

 
 

Copy URL of attachment by right clicking 
and selecting Copy Link Location or Copy 
Shortcut as outlined in Step 3 above 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
                               Figure 2: Copy URL of Attachment to Document 
 
NOTE: From this point, the proper method for inserting the hyperlinks in your document depends on 
whether you are using WordPerfect or Word to create your document.  Please refer to the appropriate section 
below depending on whether you use WordPerfect or Word.   
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 Page 3



Kansas District Court                     Using CM/ECF Cross-Document Hyperlinks 
                                                                                                December 2009 

WORDPERFECT 
 
STEP 4  In WordPerfect, open the document you want to add the hyperlink to. 
 

 In the document, select and highlight the appropriate text to be hyperlinked, such as 
“Memorandum of Law” shown in Figure 3. 

 Click Tools on the menu toolbar. 
 Select Hyperlink from the drop-down list.  

 

First, highlight text to be hyperlinked.

Second, select Hyperlink 
from Tools drop-down list. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
      Figure 3: Highlight Text to Create the Hyperlink 
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STEP 5  Next, the Hyperlink Properties dialog box appears (Figure 4). 
 

 Paste the URL of the document copied in Step 3 into the Document/Macro field of 
the Hyperlink Properties window by clicking the right mouse button and selecting Paste 
or by using the Ctrl + V command. 

 Click the OK button and the Hyperlink Properties dialog box will close. 
 The hyperlink text is now underlined indicating a hyperlink has been created. 

 
NOTE: Users may append to the URL a citation to a specific page number within the document, if 
necessary.  To do this, enter ?page=<page number> at the end of the URL, for example, 
http://usdc.uscourts.gov/doc1/00103032?incHeader=y?page=23. 
 
 
 

Document/Macro 
field. 

Paste URL by 
right clicking and 
selecting paste or 
by using the Ctrl + 
V command. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  Figure 4: Paste URL 
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STEP 6 The next step is to convert the WordPerfect document to PDF format using the Publish 
to... or Publish to PDF function in WordPerfect (Figure 5).  Converting to PDF using 
other methods will not retain the hyperlink. 

 
 Save the document 
 Click File on the menu toolbar. 
 Select Publish to... then PDF or Publish to PDF from the drop-down list (this 

selection depends on the version of WordPerfect you are using). 
 Navigate, if necessary, and store the PDF document in a local directory.  Do not print a 

WordPerfect document to Adobe PDF Writer.  You must use Publish to... or Publish 
to PDF if the document contains a hyperlink.  Printing to PDF is permitted if the 
document does not contain hyperlinks. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 Figure 5: Publish to PDF 
 
STEP 7  Save the document. 
 
STEP 8 Docket the appropriate CM/ECF event and attach the PDF document to the docket entry 

as usual. 
 
NOTE: Do not convert a WordPerfect document to Adobe PDF Writer by selecting the print option for 
Cross-Document Hyperlinks functionality.  Publish to PDF must be used if a document contains a hyperlink. 
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MICROSOFT WORD 
 
STEP 4 In Microsoft Word, open the document you want to add the hyperlink to.  
 

 In the document, select and highlight the appropriate text to be hyperlinked, such as 
“Memorandum of Law” shown in Figure 6. 

 Click Insert on the menu toolbar. 
 Select Hyperlink from the drop-down list. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

First, highlight text to be hyperlinked.

Second, select Hyperlink 
from Insert drop-down list. 

Figure 6: Highlight Text to Create Hyperlink 
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STEP 5  Next, the Insert Hyperlink dialog box appears (Figure 7). 
 

 Paste the URL of the document copied in Step 3 into the Address field of the Insert 
Hyperlink window by clicking the right mouse button and selecting Paste or by using 
the Ctrl + V command.  The URL of the CM/ECF document is pasted (displays) in the 
address field. 

 Click the OK button and the Insert Hyperlink dialog box will close. 
 The hyperlink text is now underlined indicating a hyperlink has been created. 

 
NOTE: Users may append to the URL a citation to a specific page number within the document, if 
necessary.  To do this, enter ?page=<page number> at the end of the URL, for example, 
http://usdc.uscourts.gov/doc1/00103032?incHeader=y?page=23. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Paste URL by 
right clicking and 
selecting paste or 
by using the Ctrl + 
V command. 

Address field.

Figure 7: Paste URL 
 
STEP 6 Save the document before converting to PDF. 
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STEP 7 Convert the document to PDF.  To convert a Word document to be filed in the CM/ECF 
system to PDF that contains a hyperlink, the Adobe Acrobat application must be used.  No 
other conversion software can be used. 

 
 Click the Convert to Adobe PDF icon on your menu toolbar or Adobe PDF button 

depending on the version of Word you are using (Figure 8). 
 
 
 
 
 
 
                                                
 
 
 
 
 
 
 
 
 
 
 
 
 Figure 8: Microsoft Word menu toolbar 
 

OR 
 

 Close the Word document. 
 Open Adobe Acrobat. 
 Click File on the menu toolbar (Figure 9). 
 Select Create PDF then From File (Figure 9). 
 Navigate to the appropriate directory/folder where the Word document is stored.  Select 

the document and click the Open button as shown in Figure 10.  A series of windows 
will open as the document is converted. 

 
STEP 8 When the conversion is completed, the document is displayed in the Adobe Acrobat 

window.  Save and close the Adobe file. 
 
STEP 9 Docket the appropriate CM/ECF event and attach the PDF document to the docket entry 

as usual. 
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First, select 
Create PDF from 
File list. 

Second, select 
From File. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
     Figure 9: Create PDF 
 
 
 

Second, select 
Open 

First, highlight 
the document. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 Figure 10: Converting to PDF 
 

 Page 10



Kansas District Court                     Using CM/ECF Cross-Document Hyperlinks 
                                                                                                December 2009 

CREATING HYPERLINKS BETWEEN DOCUMENTS FILED IN THE SAME EVENT 
 
It is also possible to link two or more documents to be filed in the same event (e.g., create a hyperlink in the 
main document to an attachment) even when those documents were not filed previously in CM/ECF.  To 
create a hyperlink to a document filed in the same docket event, such as an exhibit in support of a motion or 
memo of law, follow the steps below.  Again, the proper method for inserting these hyperlinks depends on 
whether you use WordPerfect or Word to create your document. 
 
NOTE: Hyperlinks in a primary document to a secondary document filed in the same submission 
do not vitiate the requirement that each exhibit or attachment to a motion or pleading (i.e., primary 
document) must also be filed as a separate attachment and individually numbered/lettered. 
 
WORDPERFECT 
 
In order to create a hyperlink in the primary WordPerfect document to a secondary document filed in the 
same event, the secondary document must be in PDF format. 
 
STEP 1 Convert the secondary document (i.e., the attachment) to PDF format using the Publish 

to... or Publish to PDF function in WordPerfect.  Converting to PDF using other methods 
will not retain the hyperlink (Figure 11).  With the secondary document open in 
WordPerfect, do the following: 

 
 Click File on the menu toolbar 
 Select Publish to... then PDF or Publish to PDF (this selection depends on the 

version of WordPerfect you are using). 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 Figure 11: Publish to PDF 
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STEP 2 Open the primary WordPerfect document that will contain the hyperlink to the secondary 
document. 

 
STEP 3 In the primary document, select and highlight the appropriate text that will be displayed as 

the hyperlink to the secondary document (Figure 12). 
 

 Select the text to be displayed as a hyperlink. 
 Click Tools on the menu toolbar. 
 Select Hyperlink from the drop-down list. 

 

First, highlight text to be hyperlinked.

Second, select Hyperlink 
from Tools drop-down list. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
         Figure 12: Highlight Text to Create the Hyperlink 
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STEP 4 Displayed next is the Hyperlink Properties dialog box.  Click the Folder icon located to the 
right of the Document/Macro field as shown in Figure 13. 

 
 

Click the Folder icon.

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 Figure 13: Creating Hyperlink to Secondary Document 
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STEP 5 Navigate to the directory/folder in which the secondary document you wish to link to is 
located (i.e., the local path name) (Figure 14).  NOTE: The document selected as the link 
must be in PDF format. 

 
 Highlight the PDF document (document must be in PDF format). 
 Click the Select button 
 Click OK on the Hyperlink Properties dialog box.  The hyperlinked text will be 

underlined. 
 
NOTE: Users may append to the URL a citation to a specific page number within the document, if 
necessary.  To do this, enter ?page=<page number> at the end of the URL, for example, 
http://usdc.uscourts.gov/doc1/00103032?incHeader=y?page=23. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Second, click the 
Select button. 

First, select the PDF 
document. 

Figure 14: Linking Document 
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STEP 6 After you have created all of your document hyperlinks, save the primary WordPerfect 
document. 

 
STEP 7 Convert the primary document to PDF format using the Publish to... or Publish to PDF 

function in WordPerfect.  Converting to PDF using other methods will not retain the 
hyperlink (Figure 15). 

 
 Click File on the menu toolbar 
 Select Publish to... then PDF or Publish to PDF (this selection depends on the 

version of WordPerfect you are using). 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
     Figure 15: Publish to PDF 
 
STEP 8 Docket the appropriate CM/ECF event and upload the primary PDF document and 

attachments as usual. 
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MICROSOFT WORD 
 
In order to create a hyperlink in the primary Word document to a secondary document filed in the same 
submission, the secondary document must be in PDF format. 
 
STEP 1 Convert the secondary document (i.e., the attachment) to PDF format.  To convert a Word 

document to be filed in the CM/ECF system to PDF format that contains a hyperlink, the 
Adobe Acrobat application must be used.  No other conversion software can be used. 

 
 Click the Convert to Adobe PDF icon on your menu toolbar or Adobe PDF button 

depending on the version of Word you are using (Figure 16). 
 
 
 
 
 
 
                                                
 
 
 
 
 
 
 
 
 
 
 
 
 Figure 16: Microsoft Word menu toolbar 
 

OR 
 

 Close the Word document. 
 Open Adobe Acrobat. 
 Click File on the menu toolbar (Figure 17). 
 Select Create PDF then From File (Figure 17). 
 Navigate to the appropriate directory/folder where the Word document is stored.  Select 

the document and click the Open button as shown in Figure 18.  A series of windows 
will open as the document is converted. 

 
STEP 2 When the conversion is completed, the document is displayed in the Adobe Acrobat 

window.  Save and close the Adobe file. 
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First, select 
Create PDF from 
File list. 

Second, select 
From File. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
     Figure 17: Create PDF 
 
 

Second, select 
Open 

First, highlight 
the document. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 Figure 18: Converting to PDF 
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STEP 3 Open the primary Word document that will contain the hyperlink to the secondary 
(attached) document. 

 
STEP 4 In the primary document, select and highlight the appropriate text that will be displayed as 

the hyperlink to the secondary document (Figure 19). 
 

 Click Insert on the menu toolbar. 
 Select Hyperlink from the drop-down list. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

First, highlight text to be hyperlinked.

Second, select Hyperlink 
from Insert drop-down list. 

Figure 19: Highlight Text to Create Hyperlink 
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STEP 5 Displayed next is the Insert Hyperlink dialog box as shown in Figure 20. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Figure 20: Creating Hyperlink to Secondary Document 
 
STEP 6 Navigate to the directory/folder in which the secondary document you wish to link to is 

located (i.e., the local path name) (Figure 21).  NOTE: The document selected as the link 
must be in PDF format. 

 
 Highlight the PDF document (document must be in PDF format). 
 Click OK on the Insert Hyperlink dialog box.  The hyperlinked text will be underlined. 

 
NOTE: Users may append to the URL a citation to a specific page number within the document, if 
necessary.  To do this, enter ?page=<page number> at the end of the URL, for example, 
http://usdc.uscourts.gov/doc1/00103032?incHeader=y?page=23. 
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Second, select OK.

First, navigate to the 
secondary document file. 

Figure 21: Linking Document 
 
STEP 7  Save the primary Word document. 
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STEP 8 Convert the primary Word document to PDF format.  To convert a Word document to be 
filed in the CM/ECF system to PDF format that contains a hyperlink, the Adobe Acrobat 
application must be used.  No other conversion software can be used.  

 
 Click the Convert to Adobe PDF icon on your menu toolbar or Adobe PDF button 

depending on the version of Word you are using (Figure 22). 
 
 
 
 
 
 
                                                
 
 
 
 
 
 
 
 
 
 
 
 
 Figure 22: Microsoft Word menu toolbar 
 

OR 
 

 Close the Word document. 
 Open Adobe Acrobat. 
 Click File on the menu toolbar (Figure 23). 
 Select Create PDF then From File (Figure 23). 
 Navigate to the appropriate directory/folder where the Word document is stored.  Select 

the document and click the Open button as shown in Figure 24.  A series of windows 
will open as the document is converted. 

 
STEP 9 When the conversion is completed, the document is displayed in the Adobe Acrobat 

window.  Save and close the Adobe file. 
 
STEP 10 Docket the appropriate CM/ECF event and upload the primary PDF document and 

attachments as usual. 
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First, select 
Create PDF from 
File list. 

Second, select 
From File. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
     Figure 23: Create PDF 
 
 

First, highlight 
the document. 

Second, select 
Open 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 Figure 24: Converting to PDF 
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ACCESSING DOCUMENTS VIA HYPERLINKS 
 
Accessing documents via a cross-document hyperlink works the same as when documents are accessed via a 
document number hyperlink in a report or query. 
 
If a non-court user clicks on a hyperlink to a CM/ECF document but has not logged in to a CM/ECF server, 
a PACER log in screen is presented before the document can be displayed.  Once a user has logged in to a 
CM/ECF server as a PACER user, this login ID will provide access to documents on other CM/ECF servers 
for the duration of the browser session or until the user logs out of the CM/ECF application.  The billing 
receipt and confirmation will be displayed to users logged in with a PACER account before the document can 
be displayed. 
 
Court users on the DCN can access unrestricted documents stored on an appellate court server via a 
hyperlink without logging in.  Court users on the DCN must log in to a district or bankruptcy court server in 
order to access unrestricted documents via a hyperlink; a PACER log in screen will be presented to the court 
user if the document is stored on another court’s server.  The PACER login ID will provide access to 
documents on the other court’s server for the duration of the browser session or until the user logs out of the 
application. 
 
If a document is restricted for any reason, the user must log in to the server on which the document resides 
with a court or attorney login ID and have the appropriate access rights to the document.  If a hyperlink to a 
restricted document is created in a document stored on anther server, the hyperlink will not access the 
document from the other server. 
 
If the user does not have access rights to a document, or a document cannot be found, an applicable message 
will be displayed. 
 
PACER BILLING SCENARIOS 
 
When a PACER user accesses a document for the first time via the Notice of Electronic Filing, he/she will 
not incur fees for accessing the newly filed document, but access to any hyperlinked document from within 
the original document will incur a fee. 
 
When a PACER user accesses a document after the first look, or accesses it from a docket sheet, he/she will 
be charged for the original document and any documents displayed when using a hyperlink. 
 
If documents filed in the same transaction contain hyperlinks to each other, the free look will be available 
from the document number hyperlink displayed on the NEF document submenu, not from the hyperlinks in 
the document themselves.  The following note was added to the document submenu screen: “To view the main 
document and its attachments without incurring a PACER fee, click on the hyperlinks displayed on this menu.  You will incur 
a PACER fee to view CM/ECF documents from hyperlinks within the documents.” 
 
If a PACER user does not have his/her PACER login already linked to his/her ECF login, he/she will be 
prompted for the PACER login for the first document he/she tries to view. 


